
Monitor Your Resources
NOTE: This section applies only to WFS Pro.

Once you’re running Talking Monitor™, it immediately starts tracking system resources, free memory, and free disk
space. If these resources fall below a specified level (10%, 128K, and 128K, respectively), the application warns you
until you resolve the problem!

The following steps describe how to change the monitor warning levels, how to change the announcement voice and
face, and how to add a warning sound.

1. Start Talking Monitor if you are not already running it by

· Windows 3.1: Clicking its button in the WFS Pro main window -OR- 
by double clicking its icon in the Talking Apps program group

· Windows 95: Clicking its program in the Talking Apps folder

The Talking Monitor window appears:

2. Choose System Resources to monitor system resources, then click the up and down arrows 
until the percentage value that you want to use appears (for example, 25%).

3. Choose Free Memory to monitor free memory, then click the up and down arrows until the 
memory size value that you want to use appears (for example, 256K).

4. Choose Free Disk Space to monitor free disk space, then click the up and down arrows until 
the drive and disk space values that you want to use appear (for example, C: 1M).

Optional: Repeat this step for each hard disk you want to monitor.

5. Optional: Choose Say stats on startup to announce current statistics for the selected monitors when you first 
run Talking Monitor.

6. Optional: Click the up and down arrows to set the Warn every number of minutes frequency value 
(for example, 10 minutes). Default is every 5 minutes.
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7. Optional: Choose Animate icon to display monitored items in the minimized Talking Monitor icon.

NOTE: When this option is not selected, Talking Monitor’s icon does not appear on the desktop. Talking Monitor still
issues warnings, however, when monitored items fall below the specified levels. You can restore Talking 
Monitor by restarting it.

8. Optional: Choose Say stats to hear current statistics for the selected monitors.

9. Click Voice… to select the voice for announcing monitored items. When the Voice dialog box appears, select a 
voice, then click OK.

10. Click Face… to select the face for announcing monitored items. When the Face dialog box appears, select a 
face, then click OK.

11. Click Sounds… to set up a sound for one or more of the selected monitors. When the Monitor Sounds dialog 
box appears, choose one of the sound buttons (for example, Low Resources Sound…). When the Choose 
Media Elements dialog box appears, select a sound, then click OK.

12. Click OK to minimize Talking Monitor. Your settings are now saved. Talking Monitor will announce monitored
items and play sounds as you requested.

NOTE: Do not exit Talking Monitor now; otherwise, it will not monitor your system.
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Liven up Your Icons
NOTE: This section applies only to WFS Pro and Talking Icons.

To breathe new life into your icons, use

· IconMotion™ to place animated icons over Program Manager’s program and program group icons, 
or anywhere on your Windows desktop (WFS Pro and Talking Icons only)

· ICM Edit™, the animated icon editor, to edit and/or create your own animated icons (WFS Pro and 
Talking Icons only)

Animate Your Program Manager Icons

NOTE: This section applies only to WFS Pro and Talking Icons.

Windows 95 Compatibility: IconMotion does not function with Windows 95; however, it does function 
with Windows 3.1 (or higher).

Norton Desktop Compatibility: IconMotion requires The Norton Desktop™ 3.0 (or higher) for full 
compatibility with Norton Desktop for Windows (NDW). If you’ve created a new icon with ICM Edit since 
opening IconMotion, exit and restart IconMotion so your new icon will appear in its list.

Once you’re running IconMotion, your icons are animated in the Main, Accessories, Aristo-Soft product
(WFS Pro, CD Mania, or Talking Icons), and After Dark (if you have After Dark!) program groups! If you want 
even more action, use IconMotion to place other animated icons onto your Windows Desktop over program and/or 
group icons. You can also place animations over Norton Desktop Quick Access Group items, minimized windows, 
and so forth!

IconMotion comes with 50 animated icons. You can use pre-made icons or icons of your own design. To create some
of your own, please refer to the “Liven up Your Icons: Create Your Own Animated Icons” section.

Place an Animated Icon

NOTE: This section applies only to WFS Pro and Talking Icons.

Windows 95 Compatibility: IconMotion does not function with Windows 95; however, it does function 
with Windows 3.1 (or higher).

Norton Desktop Compatibility: IconMotion requires The Norton Desktop™ 3.0 (or higher) for full 
compatibility with Norton Desktop for Windows (NDW). If you’ve created a new icon with ICM Edit 

since opening IconMotion, exit and restart IconMotion so your new icon will appear in its list.
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The following steps describe how to place an animated icon:

1. Access the program manager (for example, Windows or NDW).

2. Start IconMotion if you are not already running it by 

· WFS Pro in Windows 3.1: Clicking its button in the WFS Pro main window -OR- by double clicking its 
icon in the WFS Utilities program group

· Talking Icons in Windows 3.1: Clicking its button in the Talking Icons main window -OR- by double 
clicking its icon in the Talking Icons program group

The IconMotion dialog box appears, showing the available icons on the left (icon list), and a sample 
window on the right:

3. Select an icon from the list.

The selected icon is now animated in the sample window. If this is the icon you want, proceed to the next step; 
otherwise, select a different icon.

4. Click the scroll box arrows to adjust the Speed and Updates options.

Speed determines how often your system redraws the icons; Updates determines how many icons your system 
redraws at one time. As you increase speed and updates, system performance decreases; however, if you have a 
“fast” system (such as a 486–66MHz computer), performance decrease is negligible.

5. Select the icon in the sample window with the PRIMARY MOUSE button, then drag-and-drop it over the icon 
you want to animate -OR- anywhere on your Windows desktop.

The animated icon now appears in the selected location. Repeat Steps 3–5 for other icons you want to animate.

NOTE: If you want the animation to replace a Quick Access Group item or a minimized program icon, ensure the 
cursor is over the icon you’re replacing before you “drop” the animated icon.

6. Click OK. The animated icon settings are now saved.

NOTE: Do not exit IconMotion now; otherwise, icons you’ve animated will not be animated.
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Move or Remove an Animated Icon

NOTE: This section applies only to WFS Pro and Talking Icons.

Windows 95 Compatibility: IconMotion does not function with Windows 95; however, it does function 
with Windows 3.1 (or higher).

Norton Desktop Compatibility: IconMotion requires The Norton Desktop™ 3.0 (or higher) for full 
compatibility with Norton Desktop for Windows (NDW). If you’ve created a new icon with ICM Edit 

since opening IconMotion, exit and restart IconMotion so your new icon will appear in its list.

The following steps describe how to move or remove an animation:

1. Access the program manager (for example, Windows or NDW).

2. Start IconMotion if you are not already running it. The IconMotion dialog box appears.

3. Click Move. The cursor changes to

and then to

when it’s close to an animated icon.

4. Drag-and-drop the animated icon to its new location. If you want to remove it from the desktop, 
drag-and-drop it onto the IconMotion trash can icon in the lower-left corner of your screen:
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The animated icon is now moved/removed.

Optional: Repeat Steps 3–4 for other animated icons you want to move or remove.

5. Click OK. The animated icon settings are now saved.

NOTE: Do not exit IconMotion now; otherwise, other icons you’ve animated will not be animated.
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Create Your Own Animated Icons

NOTE: This section applies only to WFS Pro and Talking Icons.

ICM Edit is an animated icon editor. It lets you create your own animated icons, or edit existing ones, using an 
interface similar to Windows’ Paintbrush. You can import animations from .ICM, .MVE, .ICO, and .BMP files, even 
icon collections in .EXE and .DLL files. If you open a file type other than .ICM, .ICO, or .BMP, however, ICM Edit 
opens it as an untitled file, so you do not have to worry about overwriting the original.

NOTE: Standard icon size is 32 x 32 pixels; however, you can create larger and smaller icons if you prefer. To do 
this, click and drag the small, black box at the lower-right corner of the display window. Please be aware, 
however, resizing may visually di

stort the icon animation.

The following steps describe how to create a simple animated icon, using the Cursor Changer icon (\WFSOUND\
CURSOR.EXE) as an example. It may not be the coolest icon you’ll ever create, and it doesn’t hold 
a candle to our \WFSOUND\ICM\CURSOR.ICM. It will, however, teach you how to use the ICM Edit tools.

1. Start ICM Edit if you are not already running it by 

· WFS Pro in Windows 3.1: Clicking its button in the WFS Pro main window -OR- by double clicking its 
icon in the WFS Utilities program group

· WFS Pro in Windows 95: Clicking its program in the WFS Utilities folder

· Talking Icons in Windows 3.1: Clicking its button in the Talking Icons main window -OR- by double 
clicking its icon in the Talking Icons program group

· Talking Icons in Windows 95: Clicking its program in the Talking Icons folder

The ICM Edit window appears:

2. Choose Open… from the File menu. When the Open dialog box appears, double click the file name you want to
open. Change Directories and Drives as necessary.

For this example, select Icon Collections from the List Files of Type drop-down list box, then double click 
CURSOR.EXE. The Cursor Changer icon appears in the editing window.
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3. Choose Save As… from the File menu. When the Save As dialog box appears, type in a new file name, then 
click OK.

For this example, type CURSOR2.ICM in the File Name box and change the Directory to \WFSOUND\ICM,
then click OK.

4. Choose Insert from the Edit menu -OR- press INSERT.

Repeat this step seven more times. You should now have eight frames:

NOTE: All eight frames are there; however, only three may be visible. Select the last frame in the frame viewer -OR-
drag the scroll box along the right side of the window—more frames will appear.

5. Use the Marquee Select button and the Cut command to select and cut part of the icon from the frame.

· Select the first frame in the viewer.

· Choose

· Press and hold the PRIMARY MOUSE button over part of the icon picture, drag the mouse down toward the 
lower-right corner, then release the mouse button.

· Choose Cut from the Edit menu -OR- press CTRL+X.

The Cursor icon is now animated—look in the animation window, located above the frame viewer, to see how it
looks. Look to this window any time you add an animation to see how it looks.

6. Use the Pencil button to edit a frame.

· Select the next frame in the viewer.

· Choose
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· Optional: Change pencil color by selecting a new color (such as magenta) from the color list.

· Click a few areas within the arrow pointer, then click its shadow (dark gray) areas.

The arrow pointer is now animated.
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7. Use the Line button to edit a frame.

· Select the next frame in the viewer.

· Choose

· Optional: Change the line color (such as from magenta to blue).

· Draw an “x” over the I-beam pointer. Press and hold the PRIMARY MOUSE button near the top-left corner 
of the I-beam, drag it to the lower-right corner, then release the mouse button. Next, press and hold the 
PRIMARY MOUSE button near the top-right corner of the I-beam, drag it to the lower-left corner, then 
release the mouse button.

The I-beam pointer is now animated.

8. Use the Filled Oval button to edit a frame.

· Select the next frame in the viewer.

· Choose

· Optional: Change the outline color (such as from blue to purple). To change the fill color, press the 
SECONDARY MOUSE button on another color (such as magenta). 

· Draw an oval/circle over the Hourglass pointer. Press and hold the PRIMARY MOUSE button near the top-
left corner of the I-beam, drag it to the lower-right corner, then release the mouse button.

The Hourglass pointer is now animated.

9. Use the Hollow Oval button to edit a frame.

· Select the next frame in the viewer.

· Choose
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· Draw an oval/circle over the Hourglass pointer again. Press and hold the PRIMARY MOUSE button near the
top-left corner of the I-beam, drag it to the lower-right corner, then release the mouse button.

The Hourglass pointer is now animated with two different effects, fill and a hollow circle (oval).
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10. Use the Filled Square button to edit a frame.

· Select the next frame in the viewer.

· Choose

· Optional: Change outline and fill colors.

· Draw a square/rectangle over the Resize pointer. Press and hold the PRIMARY MOUSE button near the top-
left corner of the I-beam, drag it to the lower-right corner, then release the mouse button.

The Resize pointer is now animated.

11. Use the Hollow Square button to edit a frame.

· Select the next frame in the viewer.

· Choose

· Optional: Change the outline color.

· Draw a square/rectangle over the Resize pointer. Press and hold the PRIMARY MOUSE button near the top-
left corner of the I-beam, drag it to the lower-right corner, then release the mouse button.

The Resize pointer is now animated with two different effects, a filled and a hollow rectangle (square).
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12. Use the Fill button to edit a frame.

· Select the next frame in the viewer.

· Choose

· Optional: Change the fill color with the PRIMARY MOUSE button. 

· Click inside the Arrow pointer.

The Arrow pointer is now animated with two different effects, dots (from the pencil) and fill.

13. Choose Save from the File menu.

You may now use IconMotion to place your newly-animated icon over the existing Cursor Changer Icon 
(refer to the “Animate Your Program Manager Icons” section).

NOTE: If you’re already running IconMotion, exit and restart it so your icon will appear in its icon list.
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Create Cool Windows Effects
NOTE: This section applies only to WFS Pro and Talking Icons.

Once you’re running Windows FX™, your desktop has cool effects! You can use Windows FX to further change the 
look and feel of your Windows desktop, applying various effects, including animating menu buttons and 
title bars, changing fonts and background color, or choosing wallpapers for dialog boxes.

You can set up your own FX styles, either by using any of the preset ones listed in the FX Styles list, or combine 
some of your own effects and save them as a style, by clicking Save. If you want to save your new style as the 
default, click Make default.

NOTE: Default styles: The default style is Stainless Steel (default style appears as Default in the 
FX Styles list). If you want to change it, select a new style from the FX Styles list and click Use (for the current 

window) -OR- Make default (for all windows without a specifically-applied style). 

Exiting Windows FX: If Windows FX is driving you crazy, exit it by clicking Exit in the 
Windows FX dialog box -OR- by double clicking its program manager icon, and then clicking OK.

Windows 95 Compatibility: Windows FX functions properly with some Windows 95 applications. 
However,

some applications that do not follow standard window conventions may not be able to fully utilize the 
features of Windows FX.

This section describes how to configure button, caption, client area, and frame effects for your windows and dialog 
boxes.

Create Cool Button Effects

NOTE: This section applies only to WFS Pro and Talking Icons.

This section describes how to configure effects for your window and dialog box Control menu, Minimize, and 
Maximize buttons:

1. Start Windows FX if you are not already running it by

· WFS Pro in Windows 3.1: Clicking its button in the WFS Pro main window -OR- by double clicking its 
icon in the WFS Utilities program group

· WFS Pro in Windows 95: Clicking its program in the WFS Utilities folder

· Talking Icons in Windows 3.1: Clicking its button in the Talking Icons main window -OR- by double 
clicking its icon in the Talking Icons program group

· Talking Icons in Windows 95: Clicking its program in the Talking Icons folder
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2. Choose Configure FX… from the Control menu of the window -OR- dialog box you want to configure effects
for. The Configure FX dialog box appears:

3. Press the SECONDARY MOUSE button over the Control menu object. A popup menu of replacement boxes 
appears.

NOTE: Once Windows FX is running, you may press the SECONDARY MOUSE button on the box Control menu, 
Minimize, and Maximize buttons within the window or dialog box to which you want to apply the effects—
both open the same popup menu (that is, this replaces Steps 2–3 with one step!).

This “replacement” step, using the SECONDARY MOUSE button, is used in the “Create Cool Caption 
Effects” and “Create Cool Frame Effects” sections in place of Steps 2–3 shown above.

4. Click a button. The new button appears in the Control menu box location.

Optional: Repeat Steps 3–4 for the Minimize and Maximize button objects.

5. Press the SECONDARY MOUSE button over Caption (Title Bar) object.

6. Click Animate buttons.

7. Click OK. The effects are now saved for the selected window or dialog box. 

NOTE: Do not exit Window FX now; otherwise, effects you’ve applied will not appear.
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Create Cool Caption Effects

NOTE: This section applies only to WFS Pro and Talking Icons.

This section describes how to configure caption effects for your windows and dialog boxes:

1. Start Windows FX if you are not already running it.

2. Press the SECONDARY MOUSE button on the Caption (Title Bar) within the window -OR- dialog box you 
want to apply effects to. A popup menu of options appears.

3. Click Pattern. A popup menu of available patterns appears.

4. Select a pattern. The new pattern appears around the caption.

5. Press the SECONDARY MOUSE button on the Caption again, then choose Text font / color….
The Select Font dialog box appears:

6. Select font settings you want to apply to the Caption: Font, Font Style, Size, Effects, and Color
(for example, Antique Olive, Regular, 12, (none), and Navy, respectively).

The combined font settings appear in the Sample box. Repeat this step until you are happy with the settings.

7. Click OK. The new font appears in the caption area.
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8. Press the SECONDARY MOUSE button on the Caption again, then choose Background color….
The Color dialog box appears:

9. Select a color (for example, magenta).

10. Click OK. The new background color appears in the caption area.

11. Press the SECONDARY MOUSE button on the Caption again, then choose Ticker-tape. The caption now 
scrolls like ticker-tape.

12. Press the SECONDARY MOUSE button on Caption again, then choose Caption text. The Window Title dialog 
box appears. The following picture’s text box is filled in to match the following step.

13. Type a title in the text box (for example, My stuff).

NOTE: The title appears in place of the window or dialog box’s standard title bar caption; however,
it does not erase or remove the original caption text!

14. Click OK. The new title appears in the caption area.

15. Optional: Press the SECONDARY MOUSE button on the Caption again, then select Left, Right, or Center 
(default) if you want the caption to appear to the left, right, or center of the caption area.
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16. Choose Configure FX… from the Control menu of the window -OR- dialog box to which you applied the 
effects. The Configure FX dialog box appears:

NOTE: After applying effects, this dialog shows the applied effects in the object area (such as in the picture 
shown above). 

17. Click OK. The effects are now saved for the selected window or dialog box. 

NOTE: Do not exit Window FX now; otherwise, effects you’ve applied will not appear.

Create Cool Client Area Effects

NOTE: This section applies only to WFS Pro and Talking Icons.

This section describes how to configure client area effects for your windows and dialog boxes:

NOTE: Client area effects are not as global as other effects! These effects only work with windows 
and dialog boxes that contain a Control-menu box, standard command buttons (such as OK or Cancel), check 

boxes, option buttons, and short text labels. For example, font effects will not appear in Program Manager 
groups; however, they will appear in dialog boxes such as the Windows FX Select Font dialog box (see the 
“Create Cool Caption Effects” section).

Despite this limitation, client area wallpaper and background color effects do appear in Program 
Manager groups (for example, Main or Accessories).

1. Start Windows FX if you are not already running it.

2. Choose Configure FX… from the Control menu of the window -OR- dialog box for which you want to 
configure effects. The Configure FX dialog box appears.

3. Press the SECONDARY MOUSE button over the Example text client area. A popup menu of options appears.

4. Click Text font / color…. 

After the Select Font dialog box appears, select a color, then click OK. The new font appears in the client area.

NOTE: If you need help with this step, please refer to Steps 5–7 in the “Create Cool Caption Effects” section.

5. Press the SECONDARY MOUSE button over the Example text client area again, then choose 
Background color….

After the Color dialog box appears, select the font settings you want to apply to the text, then click OK. 
The new background color appears in the client area.

NOTE: If you need help with this step, please refer to Steps 8–10 in the “Create Cool Caption Effects” section.

User Manual for Wired for Sound Pro, CD Mania, and Talking Icons 56



6. Optional: Press the SECONDARY MOUSE button over the Example text client area again, then choose 
3D Look if you want the text to appear three dimensional.

NOTE: You must exit and re-open the window -OR- dialog box for this effect to appear. This effect works best with a
gray background color. Also, it’s only available if you’re editing a dialog box with a Control-menu box.

7. Press the SECONDARY MOUSE button over the Example text client area again, then choose Wallpaper…. 
The Select Wallpaper dialog box appears:

8. Select a wallpaper (for example, a .BMP, .RLE, or .DIB file) to attach to the selected event, changing the 
Directories and Drives as necessary.

9. Click OK. The new wallpaper appears in the client area.

10. Optional: Press the SECONDARY MOUSE button on the Example Text client area again, then select Normal 
(default), Stretch, Center, -OR- Tile if you want to change the way the wallpaper appears. 

11. Click OK. The effects settings are now saved.

NOTE: Do not exit Windows FX now; otherwise, effects you’ve configured will not appear.
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Create Cool Frame Effects

NOTE: This section applies only to WFS Pro and Talking Icons.

This feature only works for resizable frames.

This section describes how to configure frame effects for your windows and dialog boxes:

1. Start Windows FX if you are not already running it.

2. Move the cursor over the Frame (outside border) of the window -OR- dialog box to which you want to apply 
the effects.

3. Press the SECONDARY MOUSE button after the cursor changes from an arrow to a resize arrow. 
A popup menu of options appears.

4. Choose Highlight color…. When the Color dialog box appears, select a color, then click OK. The new 
highlight color appears in the frame area.

Repeat Steps 2–3 for the Face color… and Shadow color… options.

NOTE: If you need help with this step, please refer to Steps 8–10 in the “Create Cool Caption Effects” section.

5. Click OK. The effects settings are now saved.

NOTE: Do not exit Windows FX now; otherwise, effects you’ve configured will not appear.
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Track Your Mouse and Keyboard Mileage
NOTE: This section applies only to WFS Pro and Talking Icons.

Once you’re running Mouse Meter™, it tracks your mouse and keyboard “mileage.” When you close Mouse Meter, 
it stores the cumulative totals in the MMETER.INI file. Next time you run it, the cumulative totals appear so you 
can start tracking where you left off.

Start Mouse Meter if you are not already running it by 

· WFS Pro in Windows 3.1: Clicking its button in the WFS Pro main window -OR- by double clicking its 
icon in the WFS Utilities program group

· WFS Pro in Windows 95: Clicking its program in the WFS Utilities folder

· Talking Icons in Windows 3.1: Clicking its button in the Talking Icons main window -OR- by double 
clicking its icon in the Talking Icons program group

· Talking Icons in Windows 95: Clicking its program in the Talking Icons folder

The Mouse Meter window appears:

Close Mouse Meter by double clicking its window.

When you first start Mouse Meter, all the totals are zero. Afterward, it displays your cumulative totals. 
Mouse Meter displays the following four items:
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· Cumulative PRIMARY MOUSE and SECONDARY MOUSE button clicks in the first row, and the number of 
units you’ve moved the mouse. Can be tracked in pixels (default), inches, feet, or miles.

· Current system resources.

· Current number of programs or tasks you’re running, compared to what your computer system can handle.

· Keyboard clicks in the first row, and the number of words you’ve moved typed. Can be tracked in pixels 
(default), inches, feet, or miles.

If you like Mouse Meter and you want it to always run and be visible:

· Copy Mouse Meter into the StartUp group (Windows 3.1) or into the StartUp folder (Windows 95).
If you need help doing this, please refer to your Microsoft Windows User’s Manual.

· Choose Always on top (default) from the Control menu.

User Manual for Wired for Sound Pro, CD Mania, and Talking Icons 60



Add More Sights and Sounds
NOTE: This section applies only to WFS Pro and CD Mania, as appropriate.

You can further enliven your desktop with even more cool sights and sounds, using the following applications:

· WFS Pro: Wallpaper Changer™, Multimedia Screen Saver™, and Multimedia Jukebox™

· CD Mania: Wallpaper Changer and Multimedia Screen Saver

Once you’re running Wallpaper Changer, it automatically starts changing wallpaper bitmaps on your Windows’ 
desktop. And, when you’re running Multimedia Screen Saver, it automatically starts playing sounds, music, videos, 
and pictures when your system is idle. If you want to hear great sounds and music while you’re working too, just 
start up the Multimedia Jukebox.

All three applications use the same basic interface for creating and updating their playlists. You can customize the 
application’s playlist by adding or removing media elements from its playlist:

NOTE: If the selected media elements do not reside on your hard disk, insert the WFS Pro or CD Mania CD into 
your system’s CD-ROM drive now so the application can locate the files.
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The following steps describe how to create a new playlist.

1. Start Wallpaper Changer -OR- Multimedia Screen Saver -OR- Multimedia Jukebox if you are not already 
running it by 

· WFS Pro in Windows 3.1: Clicking its button in the WFS Pro main window -OR- by double clicking its 
icon in the WFS Pro program group

· WFS Pro in Windows 95: Clicking its program in the WFS Pro folder

· CD Mania in Windows 3.1: Clicking its button in the CD Mania main window -OR- by double clicking its
icon in the CD Mania program group

· CD Mania in Windows 95: Clicking its program in the CD Mania folder

The application’s window appears (see windows on previous page).

2. Choose New from the File menu. You may be asked if you want to save the current playlist first. 
If so, click Yes -OR- No.

3. Click Add…. When the Choose Media Elements dialog box appears, select one or more media elements, then 
click OK. The selected elements now appear in the playlist. If you add more elements, it appends them to the 
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list.

NOTE: If you want to remove media elements from the playlist, select the media element(s), then click Remove. 
You may use the CTRL or SHIFT key, along with your PRIMARY MOUSE button, for multiple selections. 
Remove only removes the elements from the playlist—it does not delete them from your hard disk.

4. Optional: Click Sort to sort the media elements into alphabetical order. To choose your own order, select the 
media elements you want to move, then click the Up and Down arrows to move them up and down in the list. 
You cannot move the topmost element past the top of the list, or the bottommost past the bottom of the list. 
You may use the CTRL or SHIFT key, along with your PRIMARY MOUSE button, for multiple selections.

NOTE: Playlist order only matters if you do not select the Scramble playback order Playlist option.
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5. Optional: Change any settings or options within the main window (Wallpaper Changer -OR- Multimedia 
Jukebox) -OR- click Settings… or Options… and change any settings or options, then click OK (Multimedia 
Screen Saver only). If necessary, refer to the online Help for assistance.

6. Choose Save As… from the File menu. When the Save As dialog box appears, type in or select the 
file name you want to save*, ensure the directory you’re saving to is \WFSOUND, then click OK 
to save the playlist.

* Optional: Choose the Make default (or startup) playlist option if you want this playlist (that is, 
a .WAL, .SPL, or .BOX file) to load every time you start the selected application.

7. Choose

to minimize the selected application.

NOTE: Do not exit the selected application now; otherwise, the playlists you’ve set up will not play.
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Change Your “Scape”
NOTE: This section applies only to WFS Pro.

Once you’re running MediaScape Changer, you can globally change your scape settings. Scapes include wallpaper, 
screen saver, sound, voice, and face settings global to your WFS Pro environment.

The following steps describe how to change the MediaScape. If you want to use specific face or voice settings 
different from those of the selected scape, make the changes within the selected program (for example, Talking PIM,
Talking Monitor, and so forth). 

1. Start MediaScape Changer if you are not already running it by 

· WFS Pro in Windows 3.1: Clicking its button in the WFS Pro main window -OR- by double clicking its 
icon in the WFS Pro program group

· WFS Pro in Windows 95: Clicking its program in the WFS Pro folder

The MediaScape Changer window appears:

2. Select a MediaScape in the list (for example, Female voice and face).

3. Click Select. The Load MediaScape Settings dialog box appears, defaulted to all parts selected. Select which 
parts of the selected MediaScape to use (for example, Face settings, Wired for Sound Event lists, and so forth).

NOTE: These settings override any settings currently in use (for example, if you’ve set up a specific voice or face by
way of Voice Setup or Face Setup, it overrides that setting).
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4. Click OK to use the selected parts of the scape -OR- Cancel if you do not want to select the scape. The Install 
and Remove Files dialog box appears.

5. Select (highlight) which files to remove from the previous scape and which files to install in the new scape.

6. Click Install to remove the old scape files and install the new scape files and save the new scape -OR- 
Skip to bypass this step.

7. Click Exit to exit MediaScape Changer. All applications that use scapes will now use the selected scape.
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Create and Change Sounds
NOTE: This section applies only to WFS Pro.

You can use either Wired for Sound Editor™ (WFSEdit™) or Media Manager™ to do “stuff” with your files. 
WFSEdit lets you load, record, play back, edit, and save waveform (.WAV) sounds in a variety of formats. 
Media Manager lets you play and music files, edit sound files by way of its WFSEdit interface

and manage media element files.

Record Sounds

NOTE: This section applies only to WFS Pro.

The following steps describe how to record sounds with your sound card and WFSEdit. You can also record sounds 
within any dialog containing the 

buttons; however, if you want to edit them, you should use WFSEdit for recording.

NOTE: WFS Pro and its component applications are only able to record with sound cards with record capability that 
are supported by Microsoft. Also, recording speeds vary between 11 KHz and 44.1 KHz—the record feature 
usually picks the ideal speed for your card. You may have to convert sounds recorded at higher speeds, 
however, so they play properly on slower devices. 
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1. Start WFSEdit if you are not already running it by 

· WFS Pro in Windows 3.1: Clicking its button in the WFS Pro main window -OR- by double clicking its 
icon in the WFS Utilities program group

· WFS Pro in Windows 95: Clicking its program in the WFS Utilities folder

The WFSEdit window appears:

2. Prepare the microphone or sound input device to start recording.
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3. Click

to begin recording, click

to end the recording, then click

to listen to the recording. Notice the graph of your new sound (it should look similar to this):

4. Remove silent (close to zero, flat) spots: Move the cursor to the beginning of the sound, where the graph just 
begins to move. Press the PRIMARY MOUSE button, drag the cursor to the part of the graph where the sound 
just begins to die out, then release the mouse button. Click

to listen to the recording again. Repeat this step until you’re satisfied with the sound. 

Alternative: In the picture shown in Step 3, the silent spots are in the middle of the graph. You may want to use
the Cut command to remove this. For information on using this and other editing commands, please refer to the 
next section, “Edit Sounds.”

5. Type in a description for your sound in the Description box (for example, “My first test”).

6. Choose Save As… from the File menu. When the Save Sound File As dialog box appears, type a file name in 
the File Name box (for example, “test1”). Next, select a sound format from the Save File as Type drop-down 
list box [for example, Microsoft Wave (.WAV)], then click OK. Your sound file is now saved in the selected 
format. You may now edit other files or exit WFSEdit.
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Edit Sounds

NOTE: This section applies only to WFS Pro.

The following steps describe how to edit sounds with WFSEdit:

1. Open a sound file by choosing Open… from the WFSEdit File menu. When the File Open dialog box appears, 
select a  file name (for example, BABYTOY.WAV), changing Type, Directories, and Drives as necessary, then 
click OK. 

WFSEdit graphs the sound. Use the graph as a guide to edit and refine the sound.

2. Create a backup copy of the file that you can use for editing. Choose Save As… from the File menu. 
When the Save Sound File As dialog box appears, type a new file name in the File Name list (for example, 
BABYTOY2.WAV), then click OK to return to the WFSEdit window.
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3. Edit the sound. The following table describes how to cut, paste, paste mix, echo, and amplify a sound clip. 
Other options are available. Click

at the end of each task to hear how you’ve changed the sound.

Task Cursor/Mouse Action Menu 
Selection

Cut Position the cursor where you want to Cut from 
the Edit menu.

begin the cut. Press the PRIMARY 
MOUSE button, drag the cursor to the 
point you want to end it, then release 
the mouse button.

Paste Position the cursor where you want to Paste from 
the Edit menu.

paste a cut clip.

Paste Mix Position the cursor where you want Paste Mix from the 
to begin pasting a cut clip. Press the Edit menu.
PRIMARY MOUSE button, drag the 

cursor to the point you want to end it, 
then release the mouse button.

Echo Position the cursor where you want to Echo from 
the 

begin the echo.  Press the PRIMARY Sound F/X 
menu. 

MOUSE button, drag the cursor to the 
point you want to end it, then release 
the mouse button.

Amplify Position the cursor where you want Amplify from the
to begin the amplification. Press the Sound F/X menu.
PRIMARY MOUSE button, drag the 
cursor to the point you want to end it, 
then release the mouse button.

4. Choose Save from the File menu. Your sound file is now saved in the format you selected in Step 2.

Optional: Repeat Steps 1–4 to edit other sounds -OR- choose Exit from the File menu to exit WFSEdit.
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Convert Sounds to Other Formats

NOTE: This section applies only to WFS Pro.

The .WAV files included with WFS Pro are in Compressed Wave format. To use them with 
non-WFS Pro applications, you must convert them into standard Wave format.

The following steps describe how use Media Manager to convert (transfer) a Compressed Wave sound file to 
standard Wave format:

1. Start Media Manager if you are not already running it by 

· WFS Pro in Windows 3.1: Clicking its button in the WFS Pro main window -OR- 
by double clicking its icon in the WFS Utilities program group

· WFS Pro in Windows 95: Clicking its program in the WFS Utilities folder

The Media Manager window appears:

2. Select the sound(s) or sound file name(s) you want to convert. Hold down the SHIFT -OR- CTRL key if you 
want to select multiple files.

3. Choose

The Transfer Files dialog box appears. The File format field in the following picture is filled out to match the 
following step.
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4. Select Wave from the File format drop-down list box.

5. Click OK. The selected file(s) is now converted to standard Wave format in the same directory you started with,
unless you’ve specified otherwise.  

Optional: Repeat Steps 2–5 to manage other files -OR- click Close to close Media Manager.
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Cheat at Solitaire
NOTE: This section applies to WFS Pro, CD Mania, and Talking Icons.

This section describes how to use the keyboard and mouse buttons to cheat (and win) at Solitaire. It does not tell 
you how to play :).

Start Talking Solitaire if you are not already running it by 

· WFS Pro in Windows 3.1: Clicking its button in the WFS Pro main window -OR- by double clicking its 
icon in the WFS Utilities program group

· WFS Pro in Windows 95: Clicking its program in the WFS Utilities folder

· CD Mania in Windows 3.1: Clicking its button in the CD Mania main window -OR- by double clicking its
icon in the CD Mania program group

· CD Mania in Windows 95: Clicking its program in the CD Mania folder

· Talking Icons in Windows 3.1: Clicking its button in the Talking Icons main window -OR- by double 
clicking its icon in the Talking Icons program group

· Talking Icons in Windows 95: Clicking its program in the Talking Icons folder

The (Talking) Solitaire window appears.

NOTE: Start Talking Solitaire from the specified locations; otherwise, you will access the standard, nontalking 
Windows versions! Also, Talking Solitaire will not run if you have moved the SOL.EXE file out of your 
primary Windows directory.

The following table lists keyboard key and mouse button combinations that can help you win:

Cheating Click Keyboard and Mouse

Hear the cards as they’re dealt  Deck SECONDARY MOUSE 

Hear the cards in a dealt stack  Stack SECONDARY MOUSE 

Flip over the upside-down cards
in a stack  Stack ALT+SECONDARY MOUSE

Rotate the cards in a stack from
bottom to top  Stack SHIFT+SECONDARY MOUSE
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Rotate the cards in a stack from
top to bottom  Stack CTRL+SECONDARY MOUSE
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Cheat at Minesweeper
NOTE: This section applies to WFS Pro, CD Mania, and Talking Icons.

This section describes how to use the keyboard and mouse buttons to cheat (and win) at Minesweeper. 
It does not tell you how to play :).

Start Talking Minesweeper if you are not already running it by 

· WFS Pro in Windows 3.1: Clicking its button in the WFS Pro main window -OR- by double clicking its 
icon in the WFS Utilities program group

· WFS Pro in Windows 95: Clicking its program in the WFS Utilities folder

· CD Mania in Windows 3.1: Clicking its button in the CD Mania main window -OR- by double clicking its
icon in the CD Mania program group

· CD Mania in Windows 95: Clicking its program in the CD Mania folder

· Talking Icons in Windows 3.1: Clicking its button in the Talking Icons main window -OR- by double 
clicking its icon in the Talking Icons program group

· Talking Icons in Windows 95: Clicking its program in the Talking Icons folder

The (Talking) Minesweeper window appears.

NOTE: Start Talking Minesweeper from the specified locations; otherwise, you will access the standard, nontalking 
Windows versions! Also, Talking Minesweeper will not run if you have moved the WINMINE.EXE file out of 
your primary Windows directory.

Cheating Click Keyboard and Mouse

Check for mines—warns 
“Don’t do that!” if there’s a 
mine in the selected location Field Square ALT+SECONDARY MOUSE
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Beef up Your Cursors
NOTE: This section applies to WFS Pro, CD Mania, and Talking Icons.

You can use either of the cursor applications to beef up your cursors. Cursor Changer lets you change the main eight 
Windows cursors, giving you a library of 100 designer cursors to choose from.

The following steps describe how to change a default Windows cursor:

1. Start Cursor Changer if you are not already running it by

· WFS Pro in Windows 3.1: Clicking its button in the WFS Pro main window -OR- by double clicking its 
icon in the WFS Utilities program group

· WFS Pro in Windows 95: Clicking its program in the WFS Utilities folder

· CD Mania in Windows 3.1: Clicking its button in the CD Mania main window -OR- by double clicking its
icon in the CD Mania program group

· CD Mania in Windows 95: Clicking its program in the CD Mania folder

· Talking Icons in Windows 3.1: Clicking its button in the Talking Icons main window -OR- by double 
clicking its icon in the Talking Icons program group

· Talking Icons in Windows 95: Clicking its program in the Talking Icons folder

The Cursor Changer window appears:
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2. Select a pointer type to change (for example, Standard).

3. Scroll though the cursors by clicking the scroll bar to find a replacement cursor.

4. Select a cursor. The selection becomes your new cursor. Try the new cursor in an open window. 
Repeat Steps 3–4 if it’s not to your liking.

Optional: Repeat Steps 2–4 for other pointers you want to change—be sure to change the pointer first, using 
its drop-down list box.

NOTE: Click Use default cursor if you want the default cursor.

5. Optional: Click Autoload if you want to use the new cursors in future Windows sessions. Cursor Changer will 
now automatically run at Windows StartUp [from the StartUp group (Windows 3.1) or from the StartUp folder 
(Windows 95)], activating your new cursors. If you want to remove Cursor Changer from the StartUp group or 
folder, click Don’t load.

6. Click OK to quit Cursor Changer and save your cursor changes for current and future Windows sessions.
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